PowerPoint 2003 Presentation Design

This instruction/guide will focus on:

«  Working with Master Views

* Modifying an existing design template
« Creating a custom design template
 Inserting a background graphic

« Changing font styles and bullets

«  Working with placeholders

Prerequisite:

This workshop assumes you have learned most of the basic features of PowerPoint, such as using an
outline, inserting graphics, setting transitions, using animation effects, and using the different views.

Using graphics in PowerPoint

You can use two types of graphics in PowerPoint: drawing objects and pictures. Drawing objects include
AutoShapes, curves, lines, freeforms, and WordArt drawing objects. You can use the Drawine toolbar to
change and enhance these objects with colors, patterns, borders, and other effects. Pictures are graphics
such as: scanned pictures and photographs. Scanned pictures and photographs should be converted to
either the JPEG (.jpg) format or the GIF (graphics interchange format) for insertion into PowerPoint.
Pictures should be prepared in advance before being inserted into a PowerPoint slide. That includes
picture size and resolution.

Working within the MasterViews

To change the look of the entire presentation, you need to work in the MasTer views. There are four
MasTers you can work with: SLiDE MASTER, TITLE MASTER, HANDOUT MasTER, and NoTes MasTer. For slides,
there are two masters: SLipe MasTer and TiTLe MasTer. and this guide will only include instructions for
working with the Slide Master and Title Master.

 Slide Master: The slide master stores information about the design template, including font styles,
placeholder sizes and positions, background design, and color schemes. If you want to modify a single
slide, then work in NormAL view. Finish working on the slide master before working on the title
master, because any text formatting that is changed on the slide master is changed on the title master.

« Title Master: Use the title master to make changes to slides that use a Title Slide layout. The Title
Slide layout is the first layout shown on the Slide Layout task pane. You can use the Title Master to
give title slides a different look than other slides, and they affect only slides that use the Title Slide
layouts. Title slides can be used for the beginning of the presentation or for setting off divisions in the
presentation.

PowerPoint Design templates

Design templates contain color schemes, slide and title masters with custom formatting and styled fonts,
all designed to create a certain look. PowerPoint has many pre-designed templates, but you can modify an
existing template or create your own. PowerPoint design templates have a .pot extension.



A PowerPoint design template is reusable. You can save your modified presentation design as a design
template and use it again and again. However, you will not save your design template on computers that
are used by other people. Save your template to a floppy disk or other removable drive. Modifying a
built-in design avoids the overly-used look. You can also adapt the design to function well in a room that
does not have optimum lighting. An important ingredient in a presentation is communication with the
viewers.

Open a Design Template
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1 Launch PowerPoint. See the opening screen.

2. Look at the top of the screen, at the menu bar, standard toolbar, and the formatting toolbar. This
configuration is similar in other Microsoft Office 2003 programs. Notice at the right of the screen, a
task pane is displayed. Microsoft Office 2003 programs make use of task panes in many cases instead
of dialog boxes.

See the GeTTING STARTED task pane at the right of the screen.

In the Oren section, click on CReaTE A NEw PRESENTATION.

5. The New PresenTaTioN task pane displays.
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1. In the New section, choose From Available For Use

DESIGN TEMPLATE.

2. The Suipe DesioN task pane displays. See a screen picture of this task
pane at the far right of this page.

3. Under ApprLy A DEsIGN TEMPLATE, See the section USED IN THIS PRESENTA-
TIoN. The thumbnail in this section is a blank design.

4. In the next section, RecenTLy Usep, a few thumbnails are shown. You
can choose any of these.

5. The third section is headed AvaiLasLE For Use. When you click on the
Down Arrow at the bottom of the ScroLL Bar, more thumbnails
appear in the AvaiLasLE For UsE section.

6. Scroll through the designs and click on one of your liking. As you | P
pply ta all Slides

click on each one, it displays on the slide in NormAL view.

7. If you have decided on the design you like, click on the border at the Apply to Selected Slides
right of the thumbnail and select AppLy To ALL SLIDES from the pop-up Use for Al Mew Presentations
menu that appears.
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8. If you have not decided on any of the designs, click on the Browse o aTan TR

button at the bottom left of the Stipe DesioN task pane.

9. The ArpLy DesioN TempLATE dialog displays. Click on PReseNTATION DESIGNS.

10. The ArpLy DesioN TempLATE dialog now lists the various presentation design templates in alphabetical
order.
Note: There are 44 templates, unless a user of your computer has added some. If you design a tem-
plate of your own, do not add it to the template folder on the computer unless it is a computer only
you use.

11. Asyou click on each name, a thumbnail of the slide design appears.

12. Scroll through the names of the slides, look at the thumbnails, and double-click on one of your
liking. The chosen slide appears in NorRMAL View.

12. Close the ArprLy DesicN template by clicking on the red x at the top right of the window.
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Modify the template

1. Drop down the View menu and choose MASTER.

2. Select SLibe MasTer from the sub-menu.

3. Seeat the left of the slide, the two thumbnailsthat [ yicw | tnsert  Format  Tools  Slide Show  Window  He
represent the sLIDE MAsTER and the TITLE MASTER. I_EI ol N B )
Note: Since you are using a template that has - RN A
already been created, the design will have a title
slide design as well as a slide design. & slide Show F5

4. The Suioe Desion task pane gives you these choices | Master R H—|SIiEIE Haster
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at the top of the task pane: DesiGN TEMPLATES (in
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5. Choose CoLor SCHEME.

6. Inthe AppLy A CoLoR ScHEME section, see some pre- 1
designed color schemes. E

7. Click on a color scheme and see it in full view. &) Design Templates

8. If you do not like any of the predefined color 2 E gzt Color Schemes

schemes, click on the EbiT CoLor ScHEmEs command sy Animation Schemes

Slide Design v

at the bottom of the task pane. apply a color scheme:
9. The EpiT CoLor ScHeME dialog displays. There are two tabs: the _— ~
StanpArD TAB (Which displays thumbnails of the color schemes) and - Buller - Bullet

the Custom 1AB (Which displays the colors of the thumbnail you have
chosen and allows you to change them).

10. Click on the Custom TAB and see a list of the various components of
the slide design and their colors, which you can change.




Things to consider

When modifying a design
template, think about what
you should do to the
template so that the view-
ers will be able to easily
read the slides. Consider

Edit Color Scheme

Standard | Cuskom |

Colar schemes

apply

the following:

Preview

Tip for new o0
users

IUse a light background for overheads
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Many people, especially
males, are more or less
color blind, with the
most unable to distin-
guish between red and
green. That means that
you do not use red type
over a green back-
ground.
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Change Calar...
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Be sure there is very
good contrast between
the text and the back-
ground and that the
background is not
cluttered. Use text that
has clean lines. Many people prefer sans serif fonts, such as Arial.

O

Your text size should be large enough to be seen from the back of the classroom with the lighting
dimmed (as during the presentation).

Save the modified template

1
2.
3

o

Drop down the FiLe menu.

Choose the Save As command.

In the Save As dialog, in the Save IN box, choose your floppy drive (or other removable drive) unless
you are working on your own, personal computer.

In the FiLe NamE bOX, type a name of your choosing.

In the Save as Type box, click the down arrow and choose DesiGN TEMPLATE.

Check again to see that you are saving your file at the location you want.



7. Click the Save button.

8. You can use this template instead of any of the built-in templates that are offered with

PowerPoint2003.
Create a custom template:

A custom template allows you to make your slide show represent the theme of your presentation. You can
bring in as many elements as you need: a logo, a photograph, and anything that you need to create visual
interest. However, you need to be careful not to overuse visual elements because it can be annoying if

they are overused. Overuse of graphics also makes your file large.

A JPEG image that is 10 inches wide by 7.5 inches high (the default slide measurement) is provided for
you so that you can practice importing a graphic as a slide background. If you use a picture as a slide

background, you need to make sure that it does not interfere with the text.

Creating a custom template is similar to modifying an existing design. It’s best to start from a blank
presentation so that you can determine every little detail according to your preference.

1 Launch PowerPoint 2003.

2. Look at the Oren section of the
GETTING STARTED TASK PANE, and
select CREATE A NEW PRESENTATION.

Open

Designing Effective
Presentations.ppk

3. The New PRESENTATION TASK PANE Diesigning Effective
displays Presenktations  ppk
| [ Mare. ..

4. Inthe New section, choose BLANK
PRESENTATION.

5. The Suipe LAvouT TAsk paNE dis-
plays.
Note: “Layout” refers to the way things are arranged on a slide. A
layout contains placeholders, which in turn hold text such as titles
and bulleted lists and slide content such as tables, charts, pictures,
shapes, and clip art.

6. Under the heading Text Lavouts, choose the second down from the
top left one for your bullet slide.
Note: When you work in Master view, you will create the design for
the bulk of your slides, other than title slides, first.

|_] Create a new presentation...

Work with Slide Master

1. Click on the View menu and select the Master command, then click
the SLipbe MasTeEr command on the submenu.

2. When in SLibE MAsTER view, you see the SLipe MAsTER ViEw toolbar
just above the slide and a thumbnail at the left. See a screen picture
of the SLibe MasTer toolbar with the first icon on left selected.

3. From left to right, the first icon inserts a new slide master.
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I @ = | Close Master Yiew

Insert Mew Title Master

2 5 @ = | Close Master View ’

Preserve Masker
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Delete Masker

X 7 = | Close Master Yiew

Rename Master

The second from the left icon inserts a new title master.
The third from the left deletes a master slide.
The fourth from the left is used to preserve a master slide.
The fifth from the left (or second from the last) is used to rename a master slide.

Insert a background on the Slide Master:

SO ghks W

Drop down the FormaT menu.

Choose Backerounp and see the Backerounb FiLL dialog.

Click the Down arrow at the right of the Fill box.

You are offered a choice of colors for the background.

If you do not like any of the colors offered, then click on More CoLors.
You see the CoLors dialog with two tabs: STANDARD and Custom. THE

STANDARD TAB IS shown bottom rightl

7. The STANDARD tab’s color palette gives you a choice of many colors.
When you select a color from this palette, notice in the box at the lower
right that the new color will appear in the top of the box with the
current color in the bottom. This allows you to compare the new with

the current color.

8. Ifyou find a color you want, click OK.

9. To see more colors from which to choose, click the Custom tab.
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10. On the Custom tab’s color palette, drag the cross-hair to select a
color, drag the scroll bar to adjust the brightness. You can also
specify the color by entering the Red, Green, and Blue values
directly. Click the OK button.

Use Fill Effects

1. Drop down the ForRMAT menu.

2. Choose BackcrounD and see the Backerounp FiLL dialog.
3. Click the Down arrow at the right of the fill box.
4

Background Fill apply to Al
Title of Slide apply

« Bullet ek -
= Haln
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Cmit background graphics From masker

Choose FiLL EFrecTs. The FiLL EFrecTs dialog has several tabs: GRADIENT,

TexTURE, PATTERNS, and PICTURE. O P
Gradient Fill Effects e mEE
1. The GrapienT tab allows you to choose a gradient background. More Colars. .

2. Inthe Color section, you can select ONE coLoRr, Two COLORS, OF PRESET. Fill Effacts. .
3. When you choose one color, a slider appears that allows you to darken =

or lighten the color. aradient | Texture || Pattern || Picture |
4. The bottom section of the Fill Effects

dialog, gives you a number of choices of Colors oK

a shading style. As you click through Color L:

these choices, you see what they would el ¥

look like on the slide. L AL
5. If you find a GrRaDIENT style you like, O Pregst 4 @ 2

click the OK button. Otherwise, click the Dark Light

CaNCEL button. Transparency
Texture Fill Effects bl
1 The TexTure tab gives you a choice of a Ta:

variety of textures and colors.

2. If you have developed some texture files | | =adina styles Variants

of your own, you can click on the OTHerR (® Harizontal

TexTure button, which opens the SeLect () vertical

Texture dialog. You can then browse to a () Diagonal up Sample:

location where your texture files are ) Diagonal down

stored. ") Erom cornet EZ
3. If you have found a texture you want, O From title

then click the OK button. Otherwise,

click the CANCEL button.

Fokate Fill effect with shape

Pattern Fill Effects

1. The ParTern tab displays a variety of patterns from which to choose.
2. A contrast between the foreground color and the background color gives you a background that
could be distracting. If you want to use a pattern as a background, then adjust the foreground and

background colors so there is less contrast.

3. See the ForecrouND box and the Backerounp box, with a down arrow at the right of each. Click an
arrow and see a few colors from which to choose. Click on More colors to see the Colors dialog with

the StanpaArD and CusTom palettes.

4. If you have found a texture you want, then click the OK button. Otherwise, click the CanceL button.



Picture Fill Effects

1. Click on the PicTure tab. At the right isa
screen picture of the FiLL EFFecTs PICTURE
dialog.

2. Click on the SeLecT PicTuRE button.

3. Inthe SeLecT PicTure dialog, browse and
locate a background picture that has
been prepared as a 10-inch by 7.5-inch
size JPEG picture and is suitable for a
slide background.

4. Inthe SeLecT PicTure dialog, click the
InserT button.

5. You now see the picture you have chosen
in the FiLL EFFecTs PicTURE tab.

6. Click the OK button.

7. You are now at the BACKGROUND FILL
dialog box.

8. In the Backerounp FiLL dialog, click the
ArpLy TO ALL button for the slides.

Note: If you insert a different graphic
background on your TiTLe slide master,
then click the AppLy button. The graphic
depicted at the right would be suitable
for atitle slide.

9. Close the Backerounb FiLL dialog.

Modify Text

1. Onyour Master slide, click where
instructed to edit MasTeR TITLE Style. You
can change the typeface, the text size,
and the text color.

2. Select the area to edit the MASTER TITLE

style, and drop down the FormAT menu

and choose FonT.

The Font dialog displays.

4. Click where indicated to edit MAsTER
TEXT Styles. The Arial typeface (a sans
serif style) is a good typeface to use for
slides. The color of the text should be a
color that provides a good contrast to
the background of the slide.

5. Highlight and modify the first level text,
then the second level text, etc., using the
same color for all lower level text.

6. You may wish to look at some of the
designs that are provided with
PowerPoint for ideas. To change the color
of the text, click on FormAT menu then

w
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7.

8.

on Fonr.

In the FonT dialog, click the Down ArrRow under CoLor, and either choose one of the suggested colors
or click on More CoLors.

The CoLors dialog displays. You can choose colors from the Stanpbarp tab or Custowm tab.

Modify the Bullets

AN .

Click on the line of text containing a bullet that you want to change.

Choose the BuLLETs AND NumseriNG command on the ForRMAT menu.

See the BuLLeTeD dialog displayed below left. You can choose from a variety of built-in bullet styles.
To change the color of any bullet you choose here, click on the CoLor Down Arrow and select one of
the suggested colors or choose More CoLors for a choice of many colors.

Click on the PicTure button and see the Picture BuLLeT dialog. Using the ScroLL Bar at the right of
the dialog, you can see many picture bullets from which to choose.

From the BuLLeTeD dialog, you can click on the CHARACTER button to choose a different bullet charac-
ter. From this dialog, you can click on the CoLor Down Arrow to choose a color for a bullet character
you may choose here.

Modify the Bullet Indent
When you try some bullet style other than the default style, you may run into a situation in which your

Click to edit Master title style
 Click to edit Master text styles

= Second level

= Third level
s Foyrth leve

» Fifth level

changed bullet may bump up against the text. In other words, your text may not be sufficiently indented
from the bullet. In order to change the indent space between your new bullet and the text, follow these
steps (you are still working in MAsTER VIEw):



1 Click on the View menu and choose the RuLer command.

2. See above a screen picture of the MasTer SLiDE with a large button selected for the top level. Notice
that the text is too close to the button.

3. See the ruler at the top, which you can use to modify the positioning of the bullets and the text for the
various text levels. For a good design, you will want to have your bullets and bullet colors coordinated
well at the different levels, depending on how many levels you will be using. You can always change
and update the design at any time.

Insert Page Number and Date

* You can insert page number and date in both Stipe view and SLiDE MASTER View.

« Ifyou click on Appry To ALL, it will be on all slides.

« Toinsert page numbers and dates in your presentation, choose the HEADER AND FooTER cOmmand on
the View menu.

«  Check the box DATE AND TIME t0 set the date of the presentation.

« The computer will update automatically every time you run the presentation, but it will not change
the date if you check Fixep.

«  Check SLibE NumBER t0 add a page number.

»  Check Footer to add a footer to the presentation.

¢ Check DoN’T sHow oN TITLE sLIDE if you want information shown on inner slides only.

Design a New Title Master

1 Youare still in the SLiDE MASTER view. Insert | Format  Tools  Slide Sh
2. From the InserT menu, click the New TiTLe MasTer command. ] Mew Slide Master  Cerl+M
3. If you wish, change the graphic background for the TiTLe MasTer slide | New Title Master

design, following the procedure already outlined for working with the

SLibE MasTer slides. Keep in mind the different placement of the text on Slidzs from Outline...

the TiTLE SLIDES. Picture ’
4. When finished working in the Master view, click the CLose MAsTER icon. Mavies and Sounds ,
[H_H Chart...
Format, position, and resize placeholders & Tabe..
Placeholders are boxes or hatch-marked borders that are part of most slide | =2 Hyperlink... Chrl+K
layouts. These boxes hold title and body text or objects. If you want to make || ¥

changes to a placeholder that will apply to all slides, make these changes to
the MASTER SLIDE.

Resize the Placeholder

1. Click the placeholder to select it.

2. Point to a sizing handle. (A sizing handle is one of the small circles or squares that appears at the
corners and sides of a selected object.) When the pointer becomes a two-headed arrow, drag a handle
to change the size of the placeholder. Top and bottom handles will change the vertical size. Side
handles will change the horizontal size. Corner handles will make the entire placeholder larger when
you move diagonally away from the center or smaller when you move toward the center.

3. You can also size and rotate a placeholder by clicking on the Format menu and selecting the PLace-
HOLDER command.

4. On the FormaT AuTtoSHaPE dialog, click on the Size tab.

5. In the Size AND RoTATION Section, you can specify the size in inches and also rotate the placeholder
box.

6. Inthe ScaLE section, you can set the height and/or width by percentage.



7.

If you click to select Lock AspecT RATIO, then setting either the height or width will automatically
specify the other setting. If you fill a placeholder with a bitmapped image, then be sure to lock the
aspect ratio.

Add or change a fill color or border.

S A e S\

Select the placeholder.

Click on the FormAT menu.

Click PLACEHOLDER.

The FormaT AuToSHAPE dialog displays.

Click the CoLors AND LINEs tab.

Select options under FiLL and LINE.

a.  Inthe Fill section, Color box, click the down arrow.

b. Adrop-down menu appears.

c.  You can choose a variety of colors or click More coLors to select a color from a palette.

d. You can choose FiLL EFrecTs which offers you the same choices you had for the Background.
e. If you use a picture in a placeholder box, be sure to size it appropriately in advance.

Click the OK button when finished.

Note: See below an example of a Title Slide with a photo in the background and a solid color back-
ground placed in a placeholder so that the title will be easily read over the background.

Reposition the Placeholder

1
2.

Select the placeholder.
Point to the center of the selected placeholder.

Click to edit Master title style |

il




3. When the pointer becomes a four-headed arrow, drag the placeholder to a new position.
4. You can also specify the position on the slide of the placeholder by using the PosiTion tab on the
FormAT AuToSHAPE dialog.

Specify the position of the text in the Placeholder

1. On the TexT Box tab of the Format AutoShape dialog, you can do any of the following:
Specify the text anchor point

Set the internal margin

Select WorD WRAP TEXT IN AUTOSHAPE

Select Resize AuToSHAPE to fit text.

You can also Rotate text in AutoSHAPE by 90 degrees.

© O O T o

Save your design as a template

Drop down the FiLe menu.

Select the Save As command.

Name your file.

In the Save As Tvpe box, click on the Down arrow and choose DesioN TempLATE (.poT) as the file type.
Choose the floppy drive (Drive A:) or any removable drive as the location to save the file and click
SAVE.

Apply a custom template to an existing presentation

You can apply the new design to any of your existing presentations or to a new presentation. You can
create as many templates as you need and store them on a diskette or removable drive for future use. Do
not save them with the templates that are provided by Microsoft unless you are using a computer that
only you and no one else uses.

O~

Apply the custom template to an existing presentation

Open your presentation.

Drop down the FormaT menu and choose SLiDe DESIGN.

On the SLipe DEesieN task pane, click BRowsk.

Locate and select your new design template and click Appy.
The new design will replace the previous one.

AP owpnpE

Apply the custom template to a new presentation

1. Launch Microsoft PowerPoint.

2. Atthe Opening screen, click the Open command.

3. Locate your new template and click OK.

4. You are now using your own design for your PowerPoint presentation.

Additional tips

Change the color scheme of a slide so it differs from the master

1. Display the slide you want to change.

2. On the Format menu, click Stipe CoLor ScHeME, and then click the Stanparbp tab.

3. Click the color scheme you want, and then click Appry. (You can also click the Custom tab to change
the color scheme.)

Note: Changes you make won't affect other slides or the Master unless you click AppLy To ALL.



Hide the background graphic on

an individual slide

1. Display the slide you want to change.

2. On the FormaT menu, click BACKGROUND.

3. Select the OMIT BACKGROUND GRAPHICS
FROM MASTER check box.

4. Click ArpLy to have your change affect
only the currentslide.

Pictures of the Fill Effects

Texture and PatternTabs

At the right, see pictures of the FiLL EFrecTs
TexTure and PATTERN Tabs. As previously
explained, FiLL EFrecTs can be used as slide
backgrounds and as backgrounds for PLAcE-
HOLDERS. Be cautious in their use so that the
backgrounds of the FiLL EFrecTs do not
distract from the text.
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[ Other Texture. .. J

Rokate Fill effect with shape

Patkern:

Foreground: Background:

[ v | I

Rokate Fill effect with shape

Cancel

Sample:
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Cancel
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